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Preface

Welcome to the Oracle Customer Relationship Management, Release 11i, suite of 
applications. 

This CRM Foundation Implementation guide provides information and instructions 
to help you effectively set up the Oracle CRM Foundation modules.

This preface explains how the Implementation guide is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

� Technical Service Representatives (TSR)

� Customer Service Representatives (CSR)

� System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

� Understanding of the company business processes.

� Knowledge of products and services as defined by your marketing policies.

� Basic understanding of Oracle and Developer/2000.

� Background in SQL, PL/SQL, SQL* Plus programming.
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Structure
This manual is a compilation of the topics in the online help for Oracle CRM Oracle 
Foundation components. It contains the following topic sections: 

“Understanding” topics provide overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle or third-party applications.

“Using” topics provide process-oriented, task-based procedures for using the 
application to perform essential business tasks. 

“Administering” topics provide task-based procedures for required for ongoing 
system maintenance and includes information on administration tools and utilities.

Related Documents
For more information, see the following manuals:

� Oracle CRM Foundation Concepts and Procedures Guide

� Oracle CRM Foundation Technical Reference Manual
xii



Implementing the System Administrator
Console

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
Implementing the System Administrator Console 1



Setting Up the HTML Tech Stack
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up the HTML Tech Stack
After installation of the Oracle CRM Family Pack1, the system administrator is the 
only pre-defined user of the Oracle CRM applications. The system administrator 
must create a guest user, register the user and assign roles to the user. 

Prerequisites
1. Perform the Rapid Install and any necessary patches.

For details, see Installing Oracle Applications, Release 11i (A87333-01)

2. Perform the ERP Functional Checklist.

Go to Metalink to obtain the latest version. 

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Related Documentation

Document Purpose
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Performing the Post-install Steps
Steps
Perform the following steps to setup the HTML Stack.

Performing the Post-install Steps

Prerequisites
None.

If the Apache server is running on a UNIX platform, then you must set the file 
handle limit before restarting the Apache server. Depending on the type of UNIX 
shell running, the command will be a variation of the following types of commands:

ulimit or limit.

Steps
1. Verify the limit for descriptors at the command line.

2. Set the limit for the descriptors to 1024.

For example: 

ulimit -s -n 1024 
or

limit descriptors 1024.
3. Verify your changes.

4. Restart the Apache server.

Steps Task

❏ 1 Perform post-install steps.

❏ 2 Create the guest user account

� Create a guest user account in Oracle Forms.

� Determine Application ID and Responsibility ID in Oracle Forms.

� Set up the guest user account in the Admin Console. 

� Assign business and end user default responsibilities.

� Bounce the Apache server.

❏ 3 Set profile options.

❏ 4 Run the Diagnostic Tool.
Implementing the System Administrator Console 3



Creating a Guest User Account
Creating a Guest User Account
To create a guest user account, you must perform several tasks in both Oracle forms 
and the Admin Console.

Prerequisites
Perform all steps in Performing the Post-install Steps.

Steps
1. Navigate to the System Administrator responsibility and select Security > User 

> Define. The Users window opens.

2. Enter the guest user name in the Name field. 

3. Enter a password.

You must enter the same password twice in the same field.

4. Select the responsibilities from the LOV in the Responsibility field to the guest 
user.

5. Select File > Save.

6. Repeat the steps to grant appropriate responsibilities to the end user and 
business user if possible. 

Determining Application ID and Responsibility ID
To create a guest user account, you must perform several tasks in both Oracle forms 
and the Admin Console.

Determining Application ID and Responsibility ID is the last step in creating the 
guest user account in Oracle Forms. After this step, you will continue to set up the 
guest user account in the Admin Console. 

Obtain the application and responsibility ID information. This information will be 
used later as the default responsibility. Assign it to the guest user in the Admin 
Console.

Prerequisites
Perform all steps in Creating a Guest User Account in Oracle Forms.
4 Oracle CRM Foundation Implementation Guide



Setting Up the Guest User Account in the Admin Console
Steps
1. Navigate to the System Administrator responsibility and select Security > 

Responsibility > Define. 

The Responsibilities window opens.

2. Select View > Find... from the application menu. Enter the same responsibility 
name you granted to the guest user in the Responsibility Name field.

3. Ensure that the cursor is in the Responsibility Name field and navigate to Help 
> Diagnostics > Examine... in the menu at the top of the form. 

The Examine Field and Variable Values dialog box opens. 

4. Enter the password in the Enable Diagnostics dialog box if necessary.

5. Open the Field selector. 

(Open the selector by double-clicking the “...” box next to the Field text area.) 
The Choose a Field dialog box opens.

6. Select Application_ID from the list, and click OK. Record the value that appears 
in the Value field.

7. Open the Field selector again.

8. Select Responsibility_ID from the list, and click OK. Record the value that 
appears in the Value field.

9. Click Cancel to exit the dialog box.

Setting Up the Guest User Account in the Admin Console
To create a guest user account, you must perform several tasks in both Oracle forms 
and the Admin Console.

Set up the guest user created in Oracle Forms by logging in as the System 
Administrator in the jtfdefaultlogin.jsp page. The guest user allows the jtflogin.jsp 
to work and also allows other users to self-register.

To open the jtfdefaultlogin.jsp page, enter its URL:

http://<host.domain_name>:<port>/<docroot>/jtfdefaultlogin.jsp

Use the following for the variable parameters:

� host.domain_name: The hostname where the Apache Server is installed. For 
example, apo23sum.us.oracle.com is a fully qualified host name.
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Assigning Business and End User Default Responsibilities
� port: The port on which the Apache Web listener is configured.

� docroot: The document root defined for the Apache Server that contains the jsp 
pages.

If necessary, obtain these parameters from the web system administrator.

Perform the following steps to set up a guest user.

Prerequisites
Perform all steps in Determining Application ID and Responsibility ID in Oracle 
Forms.

Steps
1. Navigate to the Admin Console jtfdefaultlogin.jsp page using the SYSADMIN 

responsibility and password SYSADMIN.

2. Select the Advanced tab and click Properties.

3. To the right of View, click on the drop down menu and select JTF.

4. Verify if guest name and password already exist. If not, click Create.

5. Update the guest_username key with the value set to the guest user’s user 
name.

6. Click Update to save your work.

7. Update the guest_password key with the value set to the guest user’s 
password.

8. Click Update to save your work.

Assigning Business and End User Default Responsibilities
To create a guest user account, you must perform several tasks in both Oracle forms 
and the Admin Console.

Registration allows two types of users:

� Business users are individuals who represent an organization. They must be 
approved through the Registration tab.

� End users are individuals who are not associated with an organization. They are 
automatically approved after the account has been created. 
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Assigning Business and End User Default Responsibilities
Example:

� Business User 1: Jane Doe works at ABC Corporation and registers as a business 
user. The System Administrator approves all business users, like Ms. Doe, 
through the Registration tab.

� Business User 2: Sally Roe works at DEF Inc. and registers as a business user. As 
her company is not currently registered, she must enter additional information 
pertinent to her company as she registers. Again, the System Administrator 
must approve her through the Registration tab.

� End User: Doug Brown does not belong to any organization or company and 
wants his own personal account. He registers and his account is automatically 
approved after the account is created.

The system administrator must assign a default responsibility to each type of user 
to implement the self-registration service. 

Use this procedure to assign a default responsibility to end users and business 
users.

Prerequisites
Perform all steps in Setting Up the Guest User Account in the Admin Console.

Steps
1. Navigate to the Admin Console jtfdefaultlogin.jsp page using the SYSADMIN 

responsibility and password SYSADMIN.

The default login page opens.

2. Select the Setup tab and click Registration > Default Responsibility. 

The Register Default Responsibility window opens.

3. Choose the appropriate account type and enter the Application ID and 
Responsibility ID that you recorded earlier for the end and business user.

4. Click Submit to complete the Default Responsibility setup.

5. Select the Setup tab and click Registration > Default Roles. 

The Select Account Type and Domain window opens. This window contains 
two lists: 

� Account Type

� Domains
Implementing the System Administrator Console 7



Bouncing the Apache Server
6. Select one item in each list and click Next. 

The Groups window opens and displays two lists:

� Available Roles

� Assigned Roles

7. Select one or more Available Roles and click > to move it to the Assigned Roles 
list. The roles in the Assigned Roles list will be assigned to the user type you 
previously selected.

� Click >> to move all Available Roles onto the Assigned Roles list.

� Click << to move all Assigned Roles onto the Available Roles list.

8. Click Update to complete the role assignment.

Bouncing the Apache Server
To create a guest user account, you must perform several tasks in both Oracle forms 
and the Admin Console.

Clean the Apache server cache and stop and start the Apache listener. It is also 
advisable to bounce any other middle tier components like WebDB listeners, TCF 
server and Forms listener.

Setting System Profile Options
Use the following list to identify the profile options that need to be set for your 
specific implementation. You can set these profile options in any order. 

� JTF_PROFILE_DEFAULT_APPLICATION

� JTF_PROFILE_DEFAULT_RESPONSIBILITY

� JTF_PROFILE_DEFAULT_CSS

� JTF_PROFILE_DEFAULT_BLANK_ROWS

� JTF_PROFILE_DEFAULT_NUM_ROWS

� JTF_PROFILE_DEFAULT_CURRENCY

�  JTF_ACCOUNT_TYPE_END_USER

� JTF_ACCOUNT_TYPE_BUSINESS_USER

� ICX_DATE_FORMAT_MASK
8 Oracle CRM Foundation Implementation Guide



Setting System Profile Options
� ICX_LANGUAGE

� ICX_TERRITORY

� ICX_CLIENT_IANA_ENCODING

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_PROFILE_DEFAULT_APPLICATION
Stores default application ID for user. Set at the User level. The default application 
ID is the application to which the user is directed after login.

Profile Option JTF_PROFILE_DEFAULT_RESPONSIBILITY
Stores default responsibility ID for user. Set at the User level. The default 
responsibility is the responsibility with which the user is logged in.

Profile Option JTF_PROFILE_DEFAULT_CSS
Stores the style sheet preference for the User. Values come from FND lookup, 
JTF-STYLE-SHEET-LOOKUP-TYPE.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

 The default value at user level is 690 for sysadmin.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value at user level is 21841 for sysadmin
Implementing the System Administrator Console 9



Setting System Profile Options
Profile Option JTF_PROFILE_DEFAULT_BLANK_ROWS
Stores the default number of blank rows to be displayed to the user. Values come 
from FND lookup, JTF_BLANK_ROWS_LOOKUP_TYPE.

Profile Option JTF_PROFILE_DEFAULT_NUM_ROWS
Stores the default number of rows to be displayed to the user. Values come from 
FND lookup, JTF_DISPLAY_ROWS_LOOKUP_TYPE.

Profile Option JTF_PROFILE_DEFAULT_CURRENCY
Stores the default currency setting of the user. Value is the currency code from 
fnd_currencies_vl_view.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value is JTFUCSS.CSS at site level.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value is 5 at site level

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value is 10 at site level
10 Oracle CRM Foundation Implementation Guide



Setting System Profile Options
Profile Option JTF_ACCOUNT_TYPE_END_USER
Stores the application ID and responsibility ID to be granted for a newly registered 
end user. The Site-level value represents the application ID; the Application-level 
value represents the responsibility ID.

Profile Option JTF_ACCOUNT_TYPE_BUSINESS_USER
Stores the application ID and responsibility ID to be granted for a newly registered 
business user. The Site-level value represents the application ID; the 
Application-level value represents the responsibility ID.

Profile Option ICX_DATE_FORMAT_MASK
Stores the date format mask. This profile is owned by AOL/J team.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Setting Description and Usage Considerations

The default value is USD at site level

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
Implementing the System Administrator Console 11



Running the Diagnostic Tool
Profile Option ICX_LANGUAGE
Stores the current/default language for the user. This profile is owned by AOL/J 
team.

Profile Option ICX_TERRITORY
Stores the current/default territory for the user. This profile is owned by AOL/J 
team.

Profile Option ICX_CLIENT_IANA_ENCODING
Stores the charset encoding information at the site level. This profile is owned by 
AOL/J team.

Running the Diagnostic Tool
Through the Diagnostic Tool, you can access system diagnostic information for both 
forms-based and HTML-based CRM modules. You are able to:

� Run diagnostic tests

� View the diagnostic reports

Access the Diagnostic Tool through one of the following:

� Click the Diagnostics link in the banner menu in the Admin Console.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Running the Diagnostic Tool
� Type in the URL in the Location Bar which is supplied by your system 
administrator, similar to:

http://<machine_name>.<domain_name>:<port_ID>/OA_HTML/jtfqalgn.htm

Running Diagnostic Tests
You can select an application product or product family to run tests against by 
choosing it from the Application LOVs. A product module must be registered with 
the Diagnostic Tool before the diagnostic tests for it become available.

The Diagnostic Tool contains three functional areas:

� Basic: Use the links on this tab to automatically run all the listed diagnostic 
tests or to run specific tests. Test input parameter values are defined on the 
Configuration tab.

� Advanced: Use the links on this tab to test specific CRM modules or groups. 
Test input parameter values for the specific test are entered directly in this 
window. 

� Configuration: Use this window for test and group administration and to 
configure any necessary test input parameters.

Viewing the Diagnostic Reports
After a test is run, a summary appears on the Results window. To access the report, 
double-click the report icon.

Note: If you are unable to access the link through the Admin 
Console, you can access the same diagnostic tests through the 
independent URL. 

Note: Consult the Diagnostic Tool user interface for a description 
of each test. 
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Workflows in HTML Tech Stack
Workflows in HTML Tech Stack
There are no Workflows associated with the HTML Stack.

Note: One issue with the HTML modules is the inability of a user 
to log in to the console. Quite frequently, this has nothing to do 
with the setup of the HTML Tech Stack or the Admin Console. The 
problem is that user data, especially numeric data, is entered 
incorrectly during user definition. This can effectively make it 
impossible to log in to the console and correct the problem. The 
independent URL for the Diagnostic Tool then becomes the portal 
for pinpointing and correcting the error.
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Implementing Territory Management

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the application successfully.

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
Implementing Territory Management 15



Setting Up Territory Management
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of Implementing Foundation, Course Description ID 8831.

Setting Up Territory Management
Prior to using Oracle Territory Management, you must set up and configure a number of 
items including qualifiers, territory types, and the specific territories.

Prerequisites
None

Steps
Perform the steps following to set up the Oracle Territory Management.

 

Implementing CRM Applications, A853401-01 Contains post-installation information on various CRM 
modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step Required? Action Window Name(s)

1 Yes Set up and/or define qualifiers.

 By default, all qualifiers are disabled. Before you 
use a qualifier to define territories, you must 
enable the qualifier. Use the Setup Qualifier 
window to enable or disable qualifiers.

You may also create your own qualifiers. See 
Creating Custom Qualifiers for details.

Setup Qualifier

2 Optional Define the territory types.

See Creating Territory types for details.

Create Territory 
Type

Related Documentation

Document Purpose
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Setting Up Territory Management
Guidelines
The following flow chart illustrates the process of setting up the Oracle Territory 
Management.

3 Yes Define the territories.

See Different Ways of Creating Territories for 
details.

Navigator

4 Yes Compile the rules using the generating rule 
engine.

This compiles all the rules you have defined into 
a Rule Engine (PL/SQL package). 

Generate Territory 
Package 
(Concurrent 
Program)

Step Required? Action Window Name(s)
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Setting Up Territory Management
Territory Manager Set Up Flow Chart
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Setting the System Profile Option
Before setting up all your territories, set up two or three first. Generate the package 
and test territory assignments to make sure that transactions are correctly assigned. 
When these few territories work correctly, continue setting up all territories.

Troubleshooting
You may find the following tips to be useful.

1. Always set up territories in hierarchical fashion. This is extremely critical for the 
Territory Manager to work properly.

2. Make the territories as generic as possible.

3. If you create a territory and do not assign resources to it, then the Territory 
Manager does not return this territory as a qualifying territory. 

This is useful if you want to define a territory merely as a place holder territory 
in the hierarchy. An example of this could be “CA Territory”.

4. You can create your own module specific “Catch All.” 

Create a territory with the highest rank and assign resources to it, but do not 
assign any qualifiers and values. In that case, the rest of the territories will then 
be defined as its children.

Setting the System Profile Option
Oracle Territory Management uses one profile option, TERR:Multiple Winning 
Territories. 

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.
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Setting the System Profile Option
Profile Option TERR:Multiple Winning Territories
This profile option sets the number of qualifying territories to return.

This system profile option controls how Territory Management assigns transactions 
to competing winning territories. This occurs whenever a transaction satisfies the 
criteria of more than one territory at any level in the territory hierarchy. 

This system profile has two possible values:

� Multiple: Territory Management assigns a transaction to all winning territories. 

� Single (the default setting): Territory Management assigns the transaction to a 
single territory at each level in the territory hierarchy. The rank of competing 
territories determines which territory is the winner.

Assume, for example, that your company organizes its territories by customer name 
and by geographical area. You have two company territories, IBM and Sun, and a 
postal code territory that encompasses all of the postal codes within the United 
States. 

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X

Setting Description and Usage Considerations

Single Winner

Multiple Winner

Select the most qualifying territory.

Select all qualifying territories.

Note that selecting the Multiple Winner option can impact performance.
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Setting the System Profile Option
If a your company receives a transaction from an IBM branch within the Unites 
States, then that transaction satisfies the criteria for both the IBM territory and the 
postal code territory.

If TERR: Multiple Winning Territories is set to multiple, then Territory Management 
assigns the transaction to both territories.

If this system profile is set to single, then Territory Management assigns the 
transaction only to the IBM territory because the IBM territory has a higher rank.
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Implementing Resource Manager

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the application successfully.

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components, Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Setting Up Oracle Resource Manager
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle Resource Manager
In addition to the pre-defined Role Types and Role Information, you can define new 
Role Types and Roles.

Steps

Defining Role Types
A Role Type is a category of roles associated with a particular CRM module. Oracle 
Resource Manager is delivered with pre-defined Role Types for all CRM modules. 
Use this procedure to define additional custom Role Types for your enterprise.

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Setup > Role Types.

The Application Object Library window displays existing Role Types.

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step 
Number Required?

Oracle Resource Manager Setup 
Step Description Window Name(s) AIW Reference

❏ 1  Optional Define Role Types Application Object Library: 
JTF_RS_ROLE_TYPE Lookups

N/A

❏ 2 Optional Define Resource Roles Roles N/A

Related Documentation

Document Purpose
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Defining Resource Roles
2. Use the down arrow to scroll to the bottom of the list of Role Types.

3. Enter the name of the new Role Type in the blank field at the bottom of the list. 

4. In the Meaning field, enter the CRM module for which this Role Type is created.

5. Choose File > Save to complete the Role Type definition.

Defining Resource Roles
A Role may encompass one or more job descriptions and job titles. Use Roles to 
assign jobs to resources, resource groups and resource teams. Oracle Resource 
Manager is delivered with pre-defined Roles for all CRM modules. Use this 
procedure to define additional custom Roles for your enterprise.

Prerequisites
Make sure that a Role Type exists with which you can associate the new Role.

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Setup > Roles.

The Roles window displays fields you can use to define a role.

2. Enter your values in the Code and Name fields. Choose a Role Type from the 
list of values.

3. Select the Active box to make the Role active. Select one or more of the job title 
boxes–Manager, Member, Admin, Lead–to associate the Role to job titles. 

4. Use one or more of the Job lines to describe jobs associated with the Role.

5. Select File > Save to complete the Role definition.

The new role name registers in the Role Name field in Resource Manager.

References
Creating and Defining Resources

Defining Dynamic Groups
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Defining Dynamic Groups
Defining Dynamic Groups
Determine the group values available to the user in Resource Manager. By defining 
the name, usage values, and effective dates of a group, you ensure the correct use of 
groups and limit the individuals who have access to create them. Use this procedure 
to define a dynamic group.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Resource Manager > 

Maintain Resources > Dynamic Groups.

The Dynamic Groups window opens.

2. Define and enter a group name in the Name field. 

3. Select a group usage from the Usage field.

4. Select the effective dates for the group from the list of values in the Start and 
End fields.

5. Enter a brief description of the group name and usage in the Description field.

6. Save the group.

The new group name registers in the Group Name field in Resource Manager.

Resource Role Boxes

Check Box Action

Member Identifies the role name as a member of the role type

Lead Identifies the role name as a lead for the role type

Active Identifies the role as active

Administration Identifies the role as administrative

Manager Identifies the role as managerial

Seeded (Read Only) Identifies the role type as seeded
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Defining Teams and Groups
Guidelines
Alternatively, you can define a group name by entering a SQL statement in the SQL 
Statement field and saving. Clicking Check Syntax checks your code for syntax 
errors.

References
Creating and Defining Resources

Defining Resource Roles

Setting Profile Options
Resource Manager does not use profile options. 

Workflows in Oracle Resource Manager
Resource Manager does not use Workflow processes. 

Defining Teams and Groups
See the following procedures for customizing Resource Manager for your 
enterprise:

Defining Resource Teams

Defining Resource Groups
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Implementing Notes

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the application successfully.

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Post-Installation Set Up Tasks for Oracle Notes
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of Implementing Foundation, Course Description ID 8831.

Post-Installation Set Up Tasks for Oracle Notes
After the Foundation modules have been installed, you may perform the following 
optional tasks:

Setting Up Note Types
Oracle Notes comes with a set of predefined note types. You can create additional 
customized note types. You may also choose to not use the predefined note types 
Perform the following steps to create new note types.

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step 
Number Required?

Oracle Notes Setup 
Step Description Window Name(s)

❏ 1 Optional Set Up Note Types Notes Setup > Note Type 
Lookups 

❏ 2 Optional Map Note Types to a Source Notes Setup > Source and 
Note Type Mapping

❏ 3 Optional Set Up the Source Object Code Task and Escalation 
Manager > Setup

Note: To delete an existing note type, assign an end date to that 
note type.

Related Documentation

Document Purpose
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Defining Note Types
Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Notes Setup node.

3. Select Note Type Setup

The Application Object Library: Note Type Lookups form window opens.

4. Define the code, meaning, and description as desired.

You only need to define a tag for a new, customized note type.

5. Save this record when you have finished.

Defining Note Types
You can configure Notes to limit the choices of task type. When you provide a list of 
values for the Note Type fields, the note creator cannot enter an incorrect value, 
Instead, the user chooses from a pre-defined menu of note types. Use this procedure 
to define note types for your users.

Prerequisites
None

Steps
1. On the application menu bar, click File and select Switch Responsibility.

The Responsibilities window opens.

2. Scroll to select Application Developer and click OK.

The Navigator - Application Developer window opens.

3. In the Functions tab, double-click Application to expand the node.

4. Double-click Lookups to expand the node.

5. Select Common and click Open.

The Application Utilities Lookups window opens.
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Mapping Note Types To a Source
6. On the application menu bar, click View, point to Query by Example, and click 
Enter.

7. In the Type field, enter JTF_NOTE_TYPE.

8. On the application menu bar, click View, point to Query by Example, and click 
Run.

The application populates the window with existing type code information.

9. Scroll down and select the last record in the multi-record block.

10. Define and enter the code, meaning, description, and effective dates.

11. Save your record.

The new note type registers in the list of values for the note type field in the 
application.

Guidelines
Choose to enable note types by selecting Enabled for the corresponding note type 
row. Initially you can create the complete set of note types, and enable the specific 
types as desired.

Mapping Note Types To a Source
When you may map a note type to a source object, you limit the visible note types 
for that source to the defined subset of note types. Perform the following steps to 
map note types to source code.

Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Notes Setup node.

3. Select Source and Note Type Mapping.

The Source to Type Mappings form window opens.

4. Select a source to map from the Source list of values.
32 Oracle CRM Foundation Implementation Guide



System Profile Options
5. Select a note type to map to it from the Note Type list of values.

6. Save this record when you have finished.

Setting Up the Source Object Code and Context
Oracle Notes provides predefined documents or source objects. When you define a 
new document, you must associate Notes usage to the new document. On the Notes 
form, the document name appears in the Source list. Each item in the Source list has 
an associated context, which appears in the Related To list. 

Perform the following steps to define the source code usage as NOTES. 

Prerequisite
You must log on under the CRM Administrator account to perform this task.

Steps
1. Select CRM Administrator from the list of logon responsibilities.

The CRM Administrator Navigator opens.

2. Expand the Task and Escalation Manager node.

3. Expand the Setup node.

4. Double-click Objects Meta-data.

The Tasks Setup: Object Type form window opens.

5. Perform one of the following tasks:

a. If the source object code you want to seed already exists, then define the 
usage as NOTES.

b. If the source object code is not defined, then you must define the source 
object code, the name, and select its details and usage. (Usage should be 
NOTES.)

6. Save this record when you have finished.

System Profile Options
Use the following list to identify the profile option(s) that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

� Notes: Default Note Status
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System Profile Options
To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option Notes: Default Note Status
Sets the default note status.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

 User chosen Chose the default note status from the provided list of values.
34 Oracle CRM Foundation Implementation Guide



Implementing Oracle Calendar

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and functions 
for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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System Profile Options
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these options in any sequence.

� JTF_CAL_ACCESS_ALL_CALENDARS

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_CAL_ACCESS_ALL_CALENDARS
Set to provide access to other Resources’ calendars.

Defining a Calendar
See the following procedures for defining and maintaining calendars:

� Defining the Calendar

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical 
Reference Manual

Contains table and view descriptions for all the Foundation 
components

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.

Related Documentation

Document Purpose
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Defining a Calendar
� Defining Availability (of resources) 

� Defining Non-availability 

� Assigning a Resource to a Calendar 

� Assigning a Calendar to a Shift 

� Assigning a Calendar to an Exception

�  Viewing the Datebook
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Implementing Task Manager

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the application successfully.

Dependencies for Tasks
The following Foundation modules must be implemented before implementing 
Oracle Tasks:

� Resource Manager

� Territory Manager

� Calendar

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

� Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.
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Setting Up Oracle Tasks
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle Tasks
Oracle Tasks comes ready to use out-of-the-box, with a number of functions 
pre-defined for you. However, if desired, you can easily customize Oracle Tasks to 
meet your business needs.

Prerequisites
First install Oracle Tasks.

Steps
Perform the following tasks to customize Oracle Tasks for your specific needs.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step Required? Action Window Name(s)

1 Optional Create new Task Statuses if you want to 
customize task statuses.

See Defining Task Status for details.

Define Task Status

2 Optional Create new Task Priorities if you want to 
customize task priorities.

See Determining Task Priority for details.

Define Task Priorities
40 Oracle CRM Foundation Implementation Guide



Defining Task Status
Defining Task Status
Limit the user’s choices of task status by defining the list of status options and 
determining the employee type that has access to each status type. When you 
provide a list of values for the Task Status field, task creators choose from a 
pre-defined template of status options. Use this procedure to define types of task 
status for your users.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

3 Optional Create new Task Types if you want to 
customize task types.

See Defining a Task Type for details.

Define Task Types

4 Optional Use the status transition model to restrict the 
status assigned to a task depending on the 
responsibility.

Set up the state transition model for each 
responsibility.

Define Task Statuses, 
click Define 
Transition

5 Optional Create new task date types.

The task data model provides three 
pre-defined date types:

� Planned

� Scheduled

� Actual

However, depending on the usage, 
additional dates can be required.

For example, if a lead requires a follow-up 
date, you might set up a Follow-up Date 
type.

Define Date Types

6 Optional Use templates if the same set of tasks are 
created repeatedly.

See Designing Task Templates for details.

Define Templates

Step Required? Action Window Name(s)
Implementing Task Manager 41



Defining Task Status
2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Status and click Open.

The Task Status window opens.

4. Define a type name and enter it in the Status field.

5. Enter a brief description of the status type in the Description field.

6. Enter the effective dates in the From and To fields.

7. Select task status flags.

For a detailed description of flag options, see the Task Status Flag Definitions 
table in the References section.

8. Optionally, define transition values that determine the user privilege for each 
status type.

Use this procedure to define transition values.

a. Click State Transition.

The State Transition window opens.

b. In the Rules tab, enter a name for the user privilege relationship in the Rule 
Name field.

c. Enter an initial and final status type for the user.

Use the initial and final status values to determine the user’s range for 
selecting task status.

d. In the Responsibility tab, enter the pre-determined rule name.

e. Enter a user type in Responsibility Name field and click OK.

A transition value stipulating user status privilege now exists.

9. Save your task status type.

The new task status and corresponding privileges register as lists of values for 
their fields in the application.
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Determining Task Priority
References

See also
Defining a Status Transition and Assigning Rules

Determining Task Priority 
Determine task priority by choosing terms for varying levels of priority and setting 
an importance rating that corresponds with each term. Use this procedure to 
determine task priority for your users.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Priority and click OK.

Task Status Flag Definitions

Flag Definition

Assigned Assigned to an individual

Working In progress

Schedulable Scheduled or re-schedulable

Accepted Accepted by owner

Rejected Rejected by owner

On Hold Temporarily not active

Approved Approved by management

Completed Completed by owner

Cancelled Cancelled by owner, creator, or management

Delete Allowed Delete acceptable without cancellation

Closed Completed and closed

Seeded Pre-defined task status
Implementing Task Manager 43



Defining Task Types
The Task Priority window opens.

4. Define a name and enter it in the Priority field.

5. Enter a numerical value in the Importance field.

Choose an importance value from a larger defined scale of priority.

6. Enter a brief description of the priority value.

7. Enter the effective dates in the From and To fields.

8. Select Seeded to restrict the edit of task priority from future users.

9. Save your task type.

The new task priority registers as a lists of value for the Priority field in the 
application.

Defining Task Types
You can configure Task Manager to limit the user’s selection of task types. When 
you provide a list of values for the Task Type field, the task creators cannot enter an 
incorrect value. Instead they choose from a pre-defined menu of task options. Use 
this procedure to define task types.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Setup to expand the node.

3. Select Task Types and click OK.

The Task Types window opens.

4. Define a name and enter it in the Type field.

5. Select from the list of values in the Workflow field.

The corresponding workflow path information populates the Task Workflow 
and Description fields.

6. Enter the effective dates in the From and To fields.

7. Enter a unit of measurement for effort in the UOM field.
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Defining Task Types
Use a measure of time to determine the UOM value.

8. Enter a number for the quantity of effort in the Qty field.

9. Select task type flags.

For a detailed description of flag options, see the Task Type Flag Definitions 
table in the References section.

10. If you want to define resource requirements from the Task Types window, then 
use this procedure.

a. Click Resource Requirement.

The Resource Requirements window opens.

b. Enter a resource name in the Name field.

c. Enter a number in the Required Units field.

Selecting the Enabled Flag activates the resource type for the corresponding 
task type.

d. Click OK.

The complete set of resource types now exists and register as lists of values 
for their task types when enabled.

11. Save your task type.

The new task type and corresponding resource types register as lists of values 
for their fields in the application.

References

Task Type Flag Definitions

Flag Definition/Action

Notification Launch notification workflow automatically.

Schedulable Reserve the resource via the Scheduler.

Billable Signify a task as a service that requires billing.

Private Restrict task availability.

Seeded Lock edit of task type from future users.
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Defining a Status Transition and Assigning Rules
Defining a Status Transition and Assigning Rules
In Oracle Tasks, you can define a group of tasks that must be performed and impose 
a sequence of statuses to the tasks. A status transition is the imposed sequence of 
statuses. 

For example, one status transition may dictate the following status sequence:

� Open

� Assigned

� Working

� Closed 

As each status in the sequence is completed, the subsequent status appears on the 
agent’s list.

In addition, you can define rules for each status transition. A status transition rule 
defines access and read-write privileges for the status transition. Rules can be 
associated to responsibilities, so that a manager may have more privileges than an 
agent.

Use the following procedure to define a status transition and assign it to a 
responsibility.

Prerequisites
Responsibilities must be created for the applications to which you are assigning 
Task Status and Task Status Transitions.

Steps
1. Login to the CRM Administrator responsibility.

2. Navigate to Task Manager > Setup > Task Status.

The Task Status window opens.

3. Click Define Transition.

The Status Transition window opens. 

4. Click the Rules tab and click the Rule Name field.

5. Select View > Find All to populate the Rules tab.
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Designing Task Templates
The Rules tab displays two lists: Current State and Next State. On any line, the 
task in the Next State list defines the task that immediately follows the task in 
the Current State list. Use this window to define the sequence of tasks in a rule.

6. To define a new rule, enter a value in the Rule Name field.

7. Click the Responsibilities tab to assign a Rule to a Responsibility.

8. Click OK to complete the association of rule to responsibility. 

Designing Task Templates
Design a task template to assist the application user in creating tasks. Creating a 
template eliminates the user’s interaction with the specific properties of a task and 
makes task creation a simple and quick process when creating redundant task 
types. Use this procedure to design task templates.

Prerequisites
None

Steps
1. In the Tasks window, click Navigator on the Task toolbar.

2. In the Task Manager Navigator, double-click Tasks to expand the node.

3. Select Task Template Group and click OK.

The Task Template Group window opens.

4. Define and enter a template group name, description and effective dates.

5. Enter a document type by selecting from the list of values.

6. Define and enter a template name, number, and description.

7. Select from the list of values in the Type, Status, and Priority fields.

8. Activate alarm and notification functions, and enter duration and planned 
effort values.

9. Select flags.

10. Optionally, click Dependencies and Recurrences.

The Task Details window opens.

11. Save your template.
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Creating and Using Task Folders
A task template now exists and task creation from a template is possible.

Guidelines
Create task templates within groups. Each task template group contains related task 
templates with full property descriptions.

References
Linking Tasks to Source Documentation 

Defining Task Type

Defining Task Status 

Determining Task Priority

Setting Task Flags 

Setting Dependencies for Tasks 

Assigning and Scheduling Resources 

Creating and Updating Tasks

Creating and Using Task Folders
This topic marker is obsolete.

System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

� JTF_TASK_DEFAULT_TASK_TYPE

� JTF_TASK_DEFAUT_TASK_STATUS

� JTF_TASK_DEFAULT_TASK_PRIORITY

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_TASK_DEFAULT_TASK_TYPE
Sets the default task type.
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Workflows
Profile Option JTF_TASK_DEFAUT_TASK_STATUS
Sets the default task status.

Profile Option JTF_TASK_DEFAULT_TASK_PRIORITY
Sets the default task priority.

Workflows
Oracle Tasks contains one pre-defined workflow:

� JTFTASK

This workflow is automatically launched under the following circumstances.

� If the auto-notification flag for the task type is set to Y (Yes).

� If certain pre-defined conditions are met.

Required

User can Admin Setting Levels

View Update User Resp App Site

X X X

Required

User can Admin Setting Levels

View Update User Resp App Site

X X X

Required

User can Admin Setting Levels

View Update User Resp App Site

X X X
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Workflows
50 Oracle CRM Foundation Implementation Guide



Implementing Oracle Interaction History

This topic group provides general descriptions of the set up and configuration tasks 
required to implement the application successfully. 

Release Dependencies
Before Oracle Interaction History is installed, these items must be installed and 
stable: 

� Oracle CRM Foundation (JTF) Resource

� JTF Tasks

� Oracle Accounts Receivable/Technical Community Architecture (AR/TCA) 
Customer Model

� Oracle Automated Marketing Services (AMS) Campaigns

Implementation of Oracle Interaction History starts with:

� The graphical user interface, either Forms or JSP versions

� Interaction History Administration, either Forms or JSP versions, or public APIs

Oracle Interaction History interacts with JTF Resource; JTF Tasks; AR/TCA 
Customer Model; AMS Campaigns.

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i
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� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

These documents range from the general to the specific, in the order listed in the 
following table.

Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Oracle Interaction History

Overview
Interaction History is a collection of tables and business logic that records touch 
points between customers and resources for Oracle Applications. Whether the touch 
point occurs between two computers, a face-to-face conversation, or over various 
media channels (such as telephony), the following patterns are true: 

� A touch point is recorded as an interaction

� An interaction is composed of a set of one or more business activities

� An interaction is historical record, once created it cannot be altered or modified

� Business activities can be related to a media item (such as phone, e-mail, or fax)

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components
52 Oracle CRM Foundation Implementation Guide



Setting Up Oracle Interaction History
Prerequisites
Interaction History is part of the Oracle CRM Foundation product suite. After CRM 
Foundation is installed, clients can access the Interaction History graphical 
interface, Administration, and public APIs to test and use Interaction History 
functionality.

Steps

Step 
Number Required?

Oracle Interaction History Setup 
Step Description

Window 
Name(s) AIW Reference

 1 Optional Define additional Outcome Codes required by 
the application in addition to the initial seeded 
values. Modify or delete existing Outcome 
Codes.

Outcomes Tab CRM Administrator 

Interaction History 
Administrator 

 2 Optional Define additional Result Codes required by the 
application in addition to the initial seeded 
values. Modify or delete existing Result codes.

Result Tab CRM Administrator 

Interaction History 
Administrator 

 3 Optional Define additional Reason Codes required by the 
application in addition to the initial seeded 
values. Modify or delete existing Reason Codes

Reason Tab CRM Administrator

Interaction History 
Administrator 

4 Optional Define additional Action Item Codes required 
by the application in addition to the initial 
seeded values. Modify or delete existing Action 
Item Codes.

Action Item 
Tab

CRM Administrator 

Interaction History 
Administrator 

5 Optional Define additional Action Codes required by the 
application in addition to the initial seeded 
values. Modify or delete existing Action codes.

Action Tab CRM Administrator

Interaction History 
Administrator 

6 Optional Define the Outcome, Result, and/or Reason 
codes as required for specific campaigns and 
promotions. 

Wrap Up Tab CRM Administrator 

Interaction History 
Administrator 

7 Optional Define unique pairs of Outcome-Results from 
existing Codes in the Outcome and Result 
tables.

Outcome 
Results

CRM Administrator

Interaction History 
Administrator

8 Optional Define unique pairs of Result-Reason from 
existing Codes in the Result and Reason tables.

Result Reasons CRM Administrator 

Interaction History 
Administrator 
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Troubleshooting Implementation of Oracle Interaction History
Guidelines
All applications that have a touch point between a customer and resource must 
record this event as an interaction via Oracle Interaction History or another 
application serving as a proxy that uses Interaction History (for example, Universal 
Work Queue). Interaction History records can be browsed and retrieved by directly 
using its graphical interface, integrating its graphical interface into an application, 
or using its views. Use the Administration tool to modify setup data; do not modify 
Interaction History tables directly.

Browsing and retrieval of interactions can be integrated by invoking the Interaction 
History graphical interface directly from an application, integrating the Interaction 
History graphical interface into an application, or using Interaction History views 
and displaying the results as needed by the application. 

Upon initiating a touch point, an interaction is created to serve as a repository for a 
set of business activities that will occur during the lifetime of the touch point. When 
a business activity is initiated, it is added to the interaction. After all business 
activities for the interaction are completed the interaction is closed, making it a 
historical record. Interactions can be browsed and retrieved during future active 
touch points or for business intelligence analysis. Media items associated with a 
business activity of an interaction are created before the interaction.

Concerns
Oracle Interaction History does not have any organizational constraints on 
operations or relationships. Oracle Interaction History does not have any 
multi-organizational tables.

Oracle Interaction History schema does not contain any table columns that are 
related to currency. Interaction History does have five translated tables which are 
used by applications for creating interactions and activities: JTF_IH_OUTCOMES; 
JTF_IH_RESULTS; JTF_IH_REASONS; JTF_IH_ACTION_ITEMS; 
JTF_IH_ACTIONS. 

Troubleshooting Implementation of Oracle Interaction History
The following problems may result in incorrect behavior for Interaction History:

� Cannot create an interaction – mandatory parameters that must be validated. 
To create an interaction, a valid party_id (customer), resource_id (agent), 
outcome_id, and handler_id (application) are required. If any of these 
parameters are invalid or missing, the create interaction APIs will fail.
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� Cannot create an interaction – optional parameters that must be validated. 
To create an interaction, the following optional parameters must be valid: 
result_id, reason_id, and campaign.

� Cannot create an activity – mandatory parameters that must be validated.
To create an activity, a valid interaction_id, action_item (business activity type) 
and outcome_id are required. If any of these parameters are invalid or missing, 
the create activity APIs will fail.

� Cannot create an activity – optional parameters that must be validated.
To create an activity, the following optional parameters must be valid: result_id, 
reason_id, action_id (sub-level detail related to business activity), media_id, 
task_id, cust_account_id, and campaign.

� Cannot create a media item – mandatory parameters that must be validated. 
To create a media item, a valid media item type and media data are required. If 
any of these parameters are invalid or missing, the create interaction APIs will 
fail.

� Cannot create an interaction, activity, or media item – failure to load 
mandatory parameter seed data. 
It is impossible to create an interaction if one of the following tables does not 
cannot seed data: outcomes and action items. These parameters must be 
validated.

� Cannot create an interaction, activity, or media item – failure to load optional 
parameter seed data. It is impossible to create an interaction if one of the 
following tables does not cannot seed data: results, reasons, and actions. It these 
parameters are set, then they must be validated.

References
Oracle CRM Foundation Components - Interaction History High-Level Design Document

Oracle CRM Foundation Components - Concepts and Procedures, Release 11i, April 2000, 
Part No. A83642-01

Setting Profile Options
Oracle Interaction History does not use profiles.
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Workflows in Oracle Interaction History
Workflows in Oracle Interaction History
 Oracle Interaction History does not use workflows.
56 Oracle CRM Foundation Implementation Guide



Implementing Oracle 1-to-1 Fulfillment

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the application successfully.

Release Dependencies
Before Oracle 1-to-1 Fulfillment is installed, these items must be installed and stable:

� Oracle CRM Foundation HTML Stack

� Oracle Interaction History

� Oracle Marketing Encyclopedia Foundation Component (MES)

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

� Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.
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Setting Up Oracle 1-to-1 Fulfillment

The Oracle Foundation HTML Stack provides the interface for Oracle 1-to-1 
Fulfillment administration. 
Following is an overview of the basic steps for setting up 1-to- 1 Fulfillment.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step Required? Description Navigation Path

1 Yes Creating an administrative user.

� Assign the JTF_FM_Admin role to the 
application administrator user.

� Assign the JTF_FM_Administrator 
responsibility to the same user.

� System Administrator:
Security > User 

� System Administrator:
Security > User > Define

2 Yes Identify the agents and the output devices you will 
use with Oracle 1-to-1 Fulfillment.

N/A

3 Yes Define the Oracle 1-to-1 Fulfillment server(s). � Fulfillment Administrator: 
Server

4 Yes Define the resource groups for each output device 
and assign groups to servers.

� Fulfillment Administrator: 
Groups

5 Yes Create and upload Master document(s). � Fulfillment Administrator:
Master Document > Upload

6 No Associate a Master document with template. � Fulfillment Administrator: > 
Template > Master Document 

7 Yes Set up and start the Fulfillment server. Oracle Applications
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Assigning the JTF_FM_ADMIN Role to the Administrator
The JTF_FM_ADMIN role for the Oracle 1-to-1 Fulfillment administrator has been 
pre-defined. Use the following procedure to assign the role to the appropriate user.

Prerequisites
The Oracle 1-to-1 Fulfillment administrator must be defined as a user and have a 
password. The administrator must have the JTF_FM_ADMINISTRATOR 
responsibility assignment.

Steps
1. Use the HTML environment to login as sysadmin.

2. In the System Administrator Console, select the Users tab and click Add.

3. In the User Registration screen, fill in the user information and click Submit.

4. In the System Administrator Console, select the Users tab.

5. Enter the Last Name of the Oracle 1-to-1 Fulfillment administrator in the Search 
field and click Go!

6. Click the user name to open the User Details window for that user.

7. Click Roles to open the User-Role Mapping window.

The Role Mapping window displays two lists: Available Roles and Assigned 
Roles.

8. Select the JTF_ADMIN role from the Available Roles list and click > to move it 
to the Assigned Roles list.

9. Click Update to complete the task of assigning the Administrator role to the 
Oracle 1-to-1 Fulfillment administrator.

Note: An End user is an individual that is not representing an 
organization.

A Business user is an individual that is representing an 
organization.
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Assigning the JTF_FM_Administrator Responsibility to the Application 
Administrator

When Oracle CRM Applications are first installed, the sysadmin user is the only 
defined user. The JTF_FM_Administrator responsibility has been predefined. You 
must assign this responsibility to the user who is the administrator for Oracle 1-to-1 
Fulfillment. Use this procedure to assign the JTF_FM_Administrator responsibility 
to the appropriate user.

Prerequisites
The Oracle 1-to-1 Fulfillment administrator user must be a registered user with a 
password. See Assigning the JTF_Admin Role to the Administrator.

Execute SQLPLUS commands to determine two values in your database: 
responsibility_id for the jtf_fm_administrator key, and application_id for JTF. 

Steps
1. Use Oracle Forms to login as the System Administrator and navigate to 

Security > User > Define.

2. Enter the Oracle 1-to-1 Fulfillment administrator’s user ID in the User Name 
field.

3. Enter the Oracle 1-to-1 Fulfillment administrator’s password in the Password 
field.

4. Choose JTF_FM_ADMINISTRATOR from the Responsibility list of values.

5. Select File > Save and Proceed, then close this window.

6. In the System Administrator window, navigate to Profile > System.

Note: To find the value of the responsibility_id for the
 jtf_fm_administrator key in your database, execute the following 
SQLPLUS command:

SELECT RESPONSIBILITY_ID FROM FND_RESPONSIBILITY 
WHERE RESPONSIBILITY_KEY = ’JTF_FM_ADMINISTRATOR’;

To find the value of the application_id for JTF in your database, 
execute the following SQLPLUS command:

SELECT APPLICATION_ID FROM FND_APPLICATION WHERE 
APPLICATION_NAME = ’JTF’;
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Define and Configure the Fulfillment Server
7. In the Find System Profiles window, select the User box and enter the Oracle 
1-to-1 Fulfillment administrator’s user name.

8. In the Profile field, enter JTF% and click Find.

The System Profile Values window displays all the profiles that begin with JTF. 
The Oracle 1-to-1 Fulfillment administrator’s user name appears at the top of 
the User column on the right.

9. Modify the following profiles by entering values in the User column:

� JTF_PROFILE_DEFAULT_APPLICATION: enter the value of the 
application_id used in your database 

� JTF_PROFILE_DEFAULT_RESPONSIBILITY: enter the value of the 
responsibility_id used in your database

� JTF_PROFILE_DEFAULT_LANG: enter US

10. Select File > Save and Proceed and return to the Find System Profiles window.

11. In the Profile list of values, enter ICX% and click Find.

12. Select ICX: LANGUAGE and set the language to your language.

13. Select File > Save.

The Oracle 1-to-1 Fulfillment administrator now has been assigned the 
appropriate responsibility.

Define and Configure the Fulfillment Server
The fulfillment server calls on database tables to supply the fulfillment collateral, 
and sends the collateral to specified output devices. You need to configure the 
fulfillment server with specific output devices and associate the output devices with 
specific agent groups.

When creating a new fulfillment server, you can follow the procedures that are 
listed on the screen in the Servers column. The procedures are listed in sequence, 
from top to bottom. 

You must define the Time format as yyyy-MM-dd HH:mm:ss.S, where:

� yyyy is the year in four digits

� MM is the month in two digits (06)

� dd is the day in two digits (04)
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(Enter a space between dd and HH)

� HH is the hour, in two digits (from 01–24) 

� mm is the minutes in two digits

� ss is the seconds in two digits

� S is milliseconds in one digit 

Prerequisites
None

Steps
1. In Oracle 1-to-1 Fulfillment, choose the Server tab.

The Server screen opens. 

2. Choose the Create button. 

The General screen opens.

3. Enter the Server Name and other information as necessary.

� In Start Time, enter the current date and the time of day that 
1-to-1 Fulfillment should begin operations. The Start time should occur 
after the date and time that the server is created. 

� In Shut Down Time, enter a date and the time of day that 1-to-1 Fulfillment 
should end operations. 

� The Description is optional.

4. Click Continue. 

See Also
� Configuring E-mail Servers

� Configuring File Servers

Defining Resource Groups and Assigning Groups to Servers
A resource group is a group of people. Each resource group must be assigned to a 
Oracle 1-to-1 Fulfillment server. Use the following procedure to define a group and 
assign it to a server.
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Configuring E-mail Servers
Prerequisites
A Oracle 1-to-1 Fulfillment server must be defined and configured. Agents must be 
registered users. 

Steps
1. In the 1-to-1Fulfillment Administrator Console, choose the Server tab and then 

click Groups > Create.

The Create Group window displays the fields you need to create a resource 
group.

2. Enter the Group Name and Description. Select the appropriate Server from the 
list.

3. In the list of Agents, click Go to begin a search of Agents.

The Select Agent window.

4. In the Select Agent window, enter the initial letter of the agent’s name with % 
and click Search.

5. Click the agent name to add the agent to the group. Repeat steps 3 and 4 for 
each of the agents you want to include in the group.

6. When the list of agents is complete, click Create.

Configuring E-mail Servers
The second step in configuring the fulfillment server is to associate the e-mail 
servers with the fulfillment server. 

Prerequisites
You must have already created the server. To begin, see Creating a New Fulfillment 
Server.

Steps
1. In the E-mail Servers screen, choose the Add button to add a new e-mail server.

 The Create E-mail Server window opens.

2. In the fields on the Create E-mail Server window, enter the information 
required to describe the e-mail server that you are adding. In the Incoming and 
Outgoing server fields, enter the IMAP or SMPT server names. 
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Configuring Fax Servers
3. Choose Save.

The E-mail Servers window appears.

4. To add more E-mail servers, repeat steps 1, 2 and 3.

Configuring Fax Servers

Configuring File Servers

Configuring Printers

Creating Groups for Servers
The last step in configuring the fulfillment server is to associate agent groups with 
the fulfillment server, and associate output devices with the groups. By associating 
a group to an output device, you indicate that the group will use that device. You 
must create an association for each agent group to each output device for which the 
group needs access. Use this procedure to associate an agent group to one or more 
output devices.

WARNING:  Screens relating to fax functionality or capability are 
not supported at this time, and should not be used.

WARNING: Screens relating to file server functionality or 
capability are not supported at this time, and should not be used.

WARNING: Screens relating to print functionality or capability 
are not supported at this time, and should not be used.
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Creating a New Template
Prerequisites
You must have already created the fulfillment server. See Define and Configure the 
Fulfillment Servers.

Steps
1. To add a group, in the Groups screen, choose the Add button.

The Select Group screen opens.

2. From the Group Name drop-down list, choose a group to associate with the 
fulfillment server.

3. Choose Go. 

The Output Devices screen opens to display a list of output device types. You 
must create an association with each output device to which the group needs 
access. 

4. From the list of values for one type of output device, choose one or more 
devices that you want to associate to the group. 

5. Click Create to create the association. Or click Clear to clear associations that 
you have selected but have not yet created.

6. Repeat step 5 and 6 for each type of output device you want to associate to the 
group.

7. Click Save to complete the association of the group to output devices.

See also
Creating New Groups

 Adding Agents to a Group

Creating a New Template
A template is a pre-defined package of brochures, newsletters, or other 
customer-oriented information that an agent can direct to customers in response to 
a fulfillment request. Text found in a template is associated to one or more master 

Note:  When a group is associated to a fulfillment server, that 
server’s file server is automatically available for the group. You do 
not need to associate a file server to a group or its agents.
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Adding a Master Document to a Template
documents. For more information on templates and how to use them, see 
Understanding Fulfillment Templates. 

To create a new template, use the following procedure.

Prerequisites
You must first create Master documents and upload them. Collateral must already 
be stored in the database.

Steps
1. Choose the Template tab and then choose Create.

The General screen opens.

2. Enter a Template Name.

3. In the Status drop-down list, choose either: 

� Active to make the template available to requests.

� Inactive to make the template unavailable to requests.

4. Optionally, in the Description field you may enter a description of the template.

5. Click Save.

The Template Master Document screen opens.

Adding a Master Document to a Template
To add a master document to a template, use the following procedure.

Prerequisites
The template must already exist. See Creating a New Template.

Steps
1. Choose the Template tab.

The View Template screen opens.

2. Choose the name of the template that you want to add.

The template details screen opens.

3. Choose the Master Document link in the left frame.
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The View Template, Master Documents screen opens.

4. Choose Go to add more master documents.

5. Choose Update to save.

Inserting Collateral into a Template
To add collateral to a template, use the following procedure.

Prerequisites
None

Steps
1. Choose the Template tab.

The View Template screen opens.

2. Choose the name of the template that you want to update.

The template details screen opens.

3. Choose the Collateral link in the left frame.

The View Template, Collateral screen opens. 

4. Choose Go to add more collateral.

5. Choose Update to save.

Setting Up and Starting the Fulfillment Server
Use the following procedure to set up the server.

Prerequisites
You must be able to log on to the System Administration Console as 
JTF_FM_ADMIN, or in a similar role, to perform the following steps. 

Note: Perform the following procedure in either a UNIX or 
Windows-NT environment.
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For details on this account, see Assigning the JTF_FM_ADMIN Role to the 
Administrator, and Assigning the JTF_FM_Administrator Responsibility to the 
Application Administrator.

Steps for creating a Fulfillment server using the SysAdmin Console
1. Log on the System Administration Console as an administrative user. (For 

example, log on as JTF_FM_ADMIN.)

2. Navigate to the Server tab, and create a new fulfillment server.

3. Note the ID number of the server. 

This number is needed in the start-up script for the server. Usually, the first time 
a server is created, it’s ID is 10000. After that, it increments by one with each 
new server.

4. Create an e-mail server to associate with the fulfillment server that you created 
in step 3. 

This is an e-mail server associate-mailted with the fulfillment server, not any 
other e-mail server. This e-mail server will need to have the outgoing e-mail 
server set. 

For many UNIX environments, you simply need to give the name of the UNIX 
box that is to run the fulfillment server. For example, this could be similar to 
AP102SES.COMPANY.COM. 

5. In the Group tab, create a group and associate a fulfillment server to that group. 
(This should preferably be the same one that you just created.)

6. Assign a user to that group. 

Note the ID of the user, since you may be submitting requests with that user.

7. Return to the Server tab and find the server that you created in step 2.

8. Double click the server name to open the general information screen.

9. Select Groups at the left hand side of the screen.

The Select Group screen opens.

10. Associate the group you created with this server, and select Go.

The Output Devices screen opens.

11. Associate an e-mail server with this server, and select Create.

12. Select Save.
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Setting Up and Starting the Fulfillment Server
13. Select the Template tab, then the Master document subtab, then select Upload.

14. Follow the upload steps to upload master documents to the server.

Steps for setting up the shell or batch script
1. Modify the classpath so that it points to both apps.zip and 3rdparty.zip

2. Create a simple batch file, or UNIX shell script, from which the server can be 
configured and executed.

Here is a batch file example:

java-ms32m-mx64m-nojit (for UNIX shell script,  add exec to the beginning of the 
line)

-Dengine.OutputDir=output
-Dengine.CommandPromptEnabled=true
-Dengine.ServerID=999
-Dengine.AOLJ.config= <path>\jtf.dbc
oracle.apps.jtf.fm.engine.processor.Processor

Parameters

� engine.OutputDir is the output directory to be used by the Fulfillment 
Dispatcher. Early versions of Fulfillment Server may not have this feature.

� engine.CommandPromptEnabled must be set to true if you want to 
interact with the Fulfillment Server via the command prompt.

� engine.ServerID specifies the ID of the server.

� engine.AOLJ.config is the location of the ’jtf.dbc’ file that the server 
needs to be able to communicate with the database.

� engine.refreshrate (optional) is the number of milliseconds between 
the status checks that the processor performs.

3. Execute the batch file or UNIX shell script to start the fulfillment server.

Guidelines: Use the following Fulfillment server commands:

� stat – Prints statistics on the current state of the fulfillment processor

� stop  – Stops the fulfillment processor

Testing Your Setup
Test your server setup by submitting a request and verifying that it shows up as 
successful in the logs. 
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System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

� JTF_FM_TEMP_DIR

� JTF_FM_OUT_DIR

� JTF_FM_EVENTS_LOG

� JTF_FM_ERROR_LOG

� JTF_FM_LOG_LEVEL

� JTF_FM_NUM_PROCESSES

� JTF_FM_MIN_PROCESSES

� JTF_FM_MAX_PROCESSES

� JTF_FM_PROCESS_IDLE

� JTF_FM_MAX_PROCESS_IDLE

� JTF_FM_REFRESH_RATE

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option JTF_FM_TEMP_DIR
Sets the temporary directory for the fulfillment engine. (This is not a full path.)

Profile Option JTF_FM_OUT_DIR
Sets the output directory for the fulfillment engine.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Profile Option JTF_FM_EVENTS_LOG
Sets the events log name for the fulfillment engine.

Profile Option JTF_FM_ERROR_LOG
Sets the error log name for the fulfillment engine.

Profile Option JTF_FM_LOG_LEVEL
Sets the level of logging detail.

Profile Option JTF_FM_NUM_PROCESSES
Sets the number of engine processes at the start up of the fulfillment engine.

Profile Option JTF_FM_MIN_PROCESSES
Sets the minimum number of processes available at any given time in the 
fulfillment engine.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Profile Option JTF_FM_MAX_PROCESSES
Sets the maximum number of processes available at any given time in the 
fulfillment engine.

Profile Option JTF_FM_PROCESS_IDLE
The number of milliseconds a process is allowed to remain idle before the processor 
starts reducing to the minimum.

Profile Option JTF_FM_MAX_PROCESS_IDLE
The number of milliseconds a process is allowed to remain idle before needing a 
refresh.

Profile Option JTF_FM_REFRESH_RATE
Description of profile option.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X
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Implementing Assignment Manager

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the application successfully.

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

� Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Setting System Profile Options
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

Setting System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these options in any sequence.

� ACTIVATE_AUTO_SELECT

� ACTIVATE_CONTRACTS_PREFERRED_ENGINEERS

� ACTIVATE_IB_PREFERRED_ENGINEERS

� ACTIVATE_WORKFLOW_NAME

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Profile Option ACTIVATE_AUTO_SELECT
Set to activate the auto-selection of resources by the Assignment Manger engine. 

The Assignment Manager engine uses this profile option setting to determine 
whether the user needs to make a selection from the provided list of resources, or if 
this task is performed automatically by the Assignment Manager engine itself.

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online 
help system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Related Documentation

Document Purpose
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Setting System Profile Options
Profile Option ACTIVATE_CONTRACTS_PREFERRED_ENGINEERS
Set to retrieve the preferred resource information from the Contracts module.

The Assignment Manager engine uses this profile option setting to determine 
whether the Contracts Preferred Engineers are picked automatically by the 
Assignment Manager engine or not.

Profile Option ACTIVATE_IB_PREFERRED_ENGINEERS
Set to retrieve the preferred resource information from the Installed Base module.

The Assignment Manager engine uses this profile option setting to determine 
whether the Installed Base Preferred Engineers are picked automatically by the 
Assignment Manager engine or not.

Profile Option ACTIVATE_WORKFLOW_NAME
Set to a user-defined workflow procedure name. 

This workflow procedure is user-programmed code for further filtering the 
resources. The Assignment Manager engine retrieves the procedure name from this 
profile option and uses it to process the user’s request. 

Setting Description and Usage Considerations

Y/N Default is Yes.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.

Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

Y/N Default is No.
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Required

User can Admin Setting Levels

View Update User Responsibility Application Site

X X X X X X X

Setting Description and Usage Considerations

None The name of a user-defined procedure.

There is no default. This is a user-defined procedure; it may or may not 
exist.
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Implementing Escalation Management

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the application successfully.

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components, Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

� Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Setting Up Escalation Management
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up Escalation Management
The Escalation Manager provides two types of escalation management:

� Reactive, or activity in response to a customer behavior

� Proactive, or an automated response to a violation of business rules

A Workflow process controls the Business Rule Monitor, which in turn periodically 
checks the business rules that have been defined. The user that owns this Workflow 
process receives notifications when the process starts and stops, and also when 
errors are detected. The user must be defined to ensure that an owner of the 
Workflow process exists and that the notifications can be sent successfully. This user 
is typically the System Administrator. 

Escalation Management provides pre-defined business rules. You may design your 
own rules that have been customized for your enterprise.

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online help 
system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Escalation Implementation Steps

Step Required? Steps to Implement Escalation Manager

1 Yes Setting the system profile options

2 Yes Setting the Escalation lookup codes

3 Yes Starting the Escalation Manager workflow process

4 Optional Defining new, customized escalation statuses

5 Optional Defining new, customized escalation reference codes

Related Documentation

Document Purpose
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Setting the Escalation Lookup Codes
Setting System Profile Options
Use the following list to identify the profile options that you need to set for your 
specific implementation. You can set these profile options in any order you like. 

To change profile options, use the standard procedure outlined in the Oracle 
Applications Users Guide.

Setting the Escalation Lookup Codes
Another required task in implementing the Escalation Manager is to set the 
following lookup codes:

� JTF_TASK_ESC_LEVEL 

� JTF_TASK_REASON_CODE

� JTF_TASK_CONTACT_TYPE

� JTF_TASK_REFERENCE_CODES

6 Optional Defining new, customized escalation reason codes

Escalation Management Profile Settings

Profile Option Value

Default Escalation Status Opened

Default Escalation Level Level 1

Default Escalation Reason Slow Progress

Default Document Type Service Request

Default Reference Type Escalation

Default Contact Type Customer

Default Contact Notify (Y/N) Checkbox Notify Checked

Default Contact Point Phone

Default New Note Type General

Escalation Implementation Steps

Step Required? Steps to Implement Escalation Manager
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Setting the Escalation Lookup Codes
Lookup Code JTF_TASK_ESC_LEVEL 
This lookup code sets escalation levels.

Lookup Code JTF_TASK_REASON_CODE 
This lookup code sets escalation reasons.

Lookup Code JTF_TASK_CONTACT_TYPE 
This lookup code sets contract types.

Lookup Code JTF_TASK_REFERENCE_CODES 
This lookup code sets reference codes for the task.

Code Meaning

DE De-escalated

L1 Level 1

NE Never escalated

Code Meaning

SLOW-PROG Slow Progress

UNACCEPTABLE_SOLUTION Unacceptable Solution

UNRES_OWN Unresponsive owner

IMP_FAILING Implementation failing

Code Meaning

CUST Customer

EMP Employee

Code Meaning

ESC Escalation

FYI For your information
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Starting the Background Workflow Process
Starting the Background Workflow Process 
Start the workflow process listed in the following table to ensure proper operation 
of the Escalation Manager.

Use the following procedure to start the required background process.

Prerequisites
None

Steps
1. In the System Administrator responsibility, navigate to Requests > Run.

The Submit a New Request window opens.

2. Select Single Request and click OK.

3. In the Submit Requests window, type W in the Name field and press the Enter 
key on the keyboard.

The Reports window opens and displays report names that begin with w.

4. Select Workflow Background Process and click OK.

The Parameters window opens.

5. Type re in the Item Type field and press the Enter key on the keyboard.

The Item Type window opens and displays items that begin with the letters "re."

6. Select Reactive Escalation Notification and click OK.

Leave the Minimum Threshold and Maximum Threshold fields empty.

7. Enter Yes for both the Process Deferred and the Process Timeout fields and click 
OK.

The Submit Request window appears in front.

8. Click Schedule on the Submit Request window.

The Schedule window appears in front.

Escalation Management Workflow

Workflow Name Description User

JTFEC Reactive Escalation Notification Escalation Manager
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Setting Up Escalation Status
9. Select Run the Job...Periodically.

More options appear for defining the time period.

10. Define the Start time and the End time.

11. In the Rerun Every fields, enter the number of minutes that defines the interval 
between job runs.

12. Select the From the Completion of the prior run box and click OK.

13. Repeat this entire procedure for each of the four workflow background 
processes

Guidelines
Set up Notifications in Oracle Workflow to ensure that notifications are sent to 
e-mail.

Setting Up Escalation Status
There are three pre-defined Escalation Statuses: 

� Open

� Working

� Closed

You may add your own user-defined statuses to these available statuses. Use the 
following procedure to add user-defined statuses.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Task and Escalation 

Manager > Setup > Define Escalation Level.

2. Enter a user-defined status in a blank field in the Status column.

3. Enter a brief description of the status type in the Description field.

Warning: Be sure to define an end time. When the end time field 
is blank, the process runs indefinitely and cannot be shut off. 
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Defining Escalation Reference Codes
4. Enter the effective dates in the From and To fields.

5. Select escalation status flags.

For a detailed list of status flag options, see the Escalation Status Flag 
Definitions table in the References section of this procedure.

6. Click the Save icon to finish defining the Escalation status. 

References

Defining Escalation Reference Codes 
A document or task may be combined with several other documents or tasks, such 
as when fulfilling a service request requires a series of tasks to be performed and 
related documents to be completed. In such a scenario, if one particular document 
or task needs to be escalated, the escalation might not apply to the other related 
items. 

When you associate an Escalation Reference to the escalated item, you point to the 
other related items and indicate their relation. There are two pre-defined Escalation 
Reference types: FYI and Escalation. 

Escalation Status Flag Definitions

Flag Definition

Assigned Assigned to an individual

Working In progress

Schedulable Scheduled or re-schedulable

Accepted Accepted by owner

Rejected Rejected by owner

On Hold Temporarily not active

Approved Approved by management

Completed Completed by owner

Cancelled Cancelled by owner, creator, or management

Delete Allowed Delete acceptable without cancellation

Closed Completed and closed

Seeded Pre-defined task status
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Defining Escalation Reason Codes
� Use FYI (for your information) to indicate the task or document is related to the 
escalated item, but is not escalated.

� Use Escalation to indicate the task or document is related to the escalated item 
and also is escalated.

You can add other Escalation Reference types to customize your escalation 
references. Use the following procedure to define customized reference types.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Task and Escalation 

Manager > Setup > Define Reference Code.

2. Enter the name of the new reference type in the first available row in the Code 
column.

3. Continue entering information in the remaining cells of the row to describe the 
escalation reference type and the effectivity dates.

4. Select the Enabled box to make the escalation reference type available.

5. Save the new Escalation Reference and close the form.

Defining Escalation Reason Codes 
You can add other escalation Reason Codes to customize your escalation reasons. 
Use the following procedure to define customized reason types.

Prerequisites
None 

Steps
1. In the CRM Administrator responsibility, navigate to Task and Escalation 

Manager > Setup > Define Reason Code.

The Escalation Reasons Lookup window appears.

2. Select the first blank line.

3. Enter a code, meaning, and description.
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Defining Escalation Reason Codes
4. Enter the effective dates in the From and To fields.

5. Select the Enabled flag.

6. Click the Save icon to finish defining the Escalation reason.
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Implementing the Business Rule Monitor

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the module successfully.

Related Documentation and Resources
You may also wish to consult the following documentation:

� Oracle Applications, Product Update Notes, Release 11i

� Installing Oracle Applications, Release 11i

� Implementing CRM Applications

� Oracle CRM Foundation Components, Concepts and Procedures

� Oracle CRM Foundation Technical Reference Manual

� Oracle Workflow Guide

These documents range from the general to the specific, in the order listed in the 
following table.

Related Documentation

Document Purpose

Oracle Applications, Product Update Notes, 
Release 11i

Contains information about new product features and 
functions for the various Oracle applications

Installing Oracle Applications, Release 11i Documents the Rapid Install installation process
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Setting Up The Business Rule Monitor
Related Courseware
The following Net Class is available on demand through Oracle University.

� 11i Overview of CRM Foundation, Course Description ID 8831.

Setting Up The Business Rule Monitor
Oracle Escalation Manager provides two types of escalation management:

� Reactive, or activity in response to a customer behavior

� Proactive, or an automated response to a violation of business rules

A workflow process controls the Business Rule Monitor, which in turn periodically 
checks the business rules that have been defined. The user that owns this workflow 
process receives notifications when the process starts and stops, and also when 
errors are detected. This user must be defined to ensure that an owner of the 
workflow process exists and that the notifications can be sent successfully. Usually, 
the workflow owner is the system administrator.

The Business Rule Monitor provides pre-defined business rules. You may design 
your own rules that have been customized for your enterprise.

Implementing CRM Applications, A85301-01 Contains post-installation information on CRM modules

Oracle CRM Foundation Components, 
Concepts and Procedures

A printed compilation of the Oracle Foundation online help 
system

Oracle CRM Foundation, Technical Reference 
Manual

Contains table and view descriptions for all the Foundation 
components

Step Required? Steps to Implement Escalation Manager

1 Yes Define the owner of the workflow process.

2 Yes Set the Business Rule Monitor system profile option.

3 Yes Start the four background Business Rule Monitor workflow 
processes 

4 Yes Start the Business Rule Monitor.

5 Optional Define new, customized business rules.

Related Documentation

Document Purpose
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Setting System Profile Options
Defining the Owner of the Workflow Process
The owner of the workflow process is assigned to an existing user. This is typically 
the system administrator or the workflow administrator.

Prerequisites
The designated workflow owner must already exist in order to assign the workflow 
process. If no workflow owner exists, then the account must first be created.

Steps
1. In the System Administrator responsibility, navigate to Security > User > 

Define.

The Users window opens.

2. Enter an existing user name in the Name field.

3. Enter a password in the Password field.

Do not press Enter to move to the next field, you must move your cursor.

4. Select the following responsibility from the list of values (LOV) in the 
Responsibility field. This grants the responsibilities to the user.

� Workflow Administrator

5. Select File > Save.

Setting System Profile Options
Use the following procedure to set the system profile option: Business Rule Monitor 
Workflow Administrator.

 You can set these profile options in any order you like. 

Prerequisites
None

6 Yes Verify that an Escalation Territory has been created and contains at 
least one resource

Step Required? Steps to Implement Escalation Manager
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Starting the Background Workflow Processes
Steps
1. In the System Administrator responsibility, navigate to Profile > System.

The Find System Profile Values window opens.

2. Enter the following in the Profile field:

Business Rule Monitor Workflow Administrator

3. Click Find to open the System Profile Values window.

4. Enter the name of the workflow administrator in the Site field. 

This user is the one that you previously named in Defining the Owner of the 
Workflow Process.

5. Select File > Save.

Starting the Background Workflow Processes
There are four predefined workflow item types. The first item type, JTFBRM, is 
internal to the Business Rule Monitor and has no user-defined attributes. The next 
three item types have specific attributes defined for each process. These attributes 
are maintained within the Business Rule Workbench, and can be viewed by clicking 
the button next to the workflow field. 

Proper operation of the Business Rule Monitor requires that these four background 
workflow processes be started before starting the Business Rule Monitor. Use the 
following procedure to start these background processes.

Prerequisites
None

Preseeded Workflow Processes

Item Types Description

JTFBRM Business Rule Monitor Main Process

JTFBRMDF Business Rule Monitor Defect Process

JTFBRMPR Business Rule Monitor Task Process

JTFBRMSR Business Rule Monitor Service Request Process
92 Oracle CRM Foundation Implementation Guide



Starting the Background Workflow Processes
Steps
1. In the System Administrator responsibility, navigate to Requests > Run.

The Submit a New Request window opens.

2. Select Single Request and click OK.

3. In the Submit Requests window, type W in the Name field and press the Enter 
key on the keyboard.

The Reports window opens and displays report names that begin with w.

4. Select Workflow Background Process and click OK.

The Parameters window opens.

5. Type bu in the Item Type field and press the Enter key on the keyboard.

The Item Type window opens and displays the four Workflow background 
processes required by the Business Rule Monitor.

6. Select one of the four Business Rule Monitor processes and click OK.

Leave the Minimum Threshold and Maximum Threshold fields empty.

7. Enter Yes in the Process Deferred field, and in the Process Timeout field and 
click OK.

The Submit Request window appears in front.

8. Click Schedule on the Submit Request window.

The Schedule window appears in front.

9. Select Run the Job...Periodically.

More options appear for defining the time period.

10. Define the Start time and the End time.

11. In the Rerun Every fields, enter the number of minutes that defines the interval 
between job runs.

12. Select the From the Completion of the prior run box and click OK.

Warning: Be sure to define an end time. When the end time field 
is blank, the process runs indefinitely and cannot be shut off. 
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Starting the Business Rule Monitor
13. Repeat this entire procedure for each of the four workflow background 
processes.

Guidelines
Set up Notifications in Oracle Workflow to ensure that notifications are sent to 
e-mail.

Starting the Business Rule Monitor
The Business Rule Monitor monitors the workflow processes. In the Business Rule 
Monitor, you must indicate how often the monitor checks the rules. Once the 
Business Rule Monitor is started, there is no need to start it again, even after 
defining new business rules. Use this procedure to start the Business Rule Monitor.

See also
Starting the Background Workflow Processes.

Prerequisites
The four Workflow background processes for the Business Rule Monitor must be 
started before starting the Business Rule Monitor. If you have designed customized 
workflow background processes, they must also be started. In addition, the Business 
Rule Monitor Administrator profile option must be set.

Steps
1. In the CRM Administrator responsibility, navigate to Business Rule Monitor > 

Business Rule Monitor.

The Business Rule Monitor opens.

2. Enter the time period in the Interval field. Enter a time unit (minutes or hours) 
in the UOM field.

3. Click Save.

4. Click Start to activate the Business Rule Monitor. 

A dialog box confirms that the Business Rule Monitor started successfully. 

Click Workflow Monitor to view details of this process.

Guidelines
After the monitor is started, the Stop button appears. Click Stop to stop the monitor.
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Defining a Business Rule
Click Refresh Status to get an immediate status on the Workflow background 
processes.

Defining a Business Rule 
In addition to the pre-defined business rules provided with the Business Rule 
Monitor, you can define your own business rules. Use the following procedure to 
define a business rule.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Business Rule Monitor > 

Business Rules Monitor Workbench.

The Business Rules Monitor Workbench window opens.

2. Enter values for the following:

� Name: The name of the new business rule

� Object: The type of business rule

� Check Rule Every: The time interval that you want

� Workflow: Chose a workflow from the drop down menu.

Attributes can be defined for the Workflow and an Owner for the business rule.

3. Use the fields in the Simple tab to construct a PL/SQL statement that defines 
the conditions under which the business rule is triggered. 

4. Click Validate to check the syntax of the PL/SQL statement defined in the 
Simple tab. The syntax check verifies whether or not the syntax is correct. 

A dialog box confirms that the syntax validation was successful. Click OK.

Click Generate. A dialog box confirms that your business rule has been 
generated.

5. Select File > Save.
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Verifying Escalation Territory Creation
Verifying Escalation Territory Creation
An escalation territory is a placeholder for resources that you want to put into 
service under certain conditions. Escalation territories are defined in Oracle 
Territory Management. Ensure that at least one resource is identified in the Catch 
All Escalation Territory.

See also
View the following topics in Territory Manager for additional information:

� Basic Territory Building Blocks

� Viewing Escalation Territories

� Creating Escalation Territories
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Implementing Dynamic Tables

This topic group provides general descriptions of the setup and configuration tasks 
required to implement the spreadtable successfully.

Creating a New Dynamic Table
Use the Spreadtable Meta Data Administration window to design spreadtables that 
plug into an Oracle Forms bean area container. 

� A spreadtable is the user interface component that contains rows, columns, and 
column headers set in a grid that can be embedded into an Oracle form.

� Oracle Forms-based CRM modules use the spreadtable to display and format 
dynamically retrieved data at run time. This is accomplished by predefined 
metadata definitions.

� Metadata is information that defines what data is retrieved at run time and how 
that information is presented.

 

Tab Description

Database Use to set column type and order, datatype, sequence, and default sort order.

Display Use to set column label, visibility, display sequence, and display width.

Alignment and Formatting Use to set type of header and cell alignment, as well as display type and format.

Custom Format Masks and 
Mappings

Use to set how data displays. This applies only to columns with datatype of 
Number. For example, it would display the values as a percent.
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Creating a New Dynamic Table
Perform the following steps to create a new spreadtable.

Prerequisites
None

Steps
1. In the CRM Administrator responsibility, navigate to Spreadtable 

Administration.

The Spreadtable Meta Data Administration window opens.

2. Define a new datasource (a set of metadata) by entering the following:

� Datasource Name: The unique name that identifies a set a metadata. It 
must always be <Application Prefix>_<Name>.

� Application: The name of your product. 

� Title: A descriptive name for this set of metadata.

Query Used exclusively by Universal Work Queue. It is for internal use only.

Sort Order Use to set the overall sort order of the columns for the spreadtable. For example, 
you may set the primary sort order to be alphabetical based on column A, and set 
a secondary sort order to be numerical based on column B. 

Test Use to test the spreadtable that you are defining. 

Warning: Note the following:

Oracle does not support custom development of new forms using the 
spreadtable interface.

Do not delete currently existing columns when modifying an existing 
spreadtable. Instead, use the Freeze Visible State property in the Display 
tab to make the column invisible to the user. 

Do not delete any existing metadata definitions.

If you modify existing metadata definitions, these changes may be 
overwritten by subsequent patches.

 

Tab Description
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Creating a New Dynamic Table
� Relational View Name: Select from the LOVs the name of the view from 
which information is to be retrieved to populate the spreadtable.

� Lines/Rows: Enter how many lines of text are to display per row.

� WHERE Clause: (Optional) Enter a SQL statement here if desired. Use this 
field to enter filtering criteria. NEVER start with the keyword WHERE, as 
this is automatically prepended to the statement. Always use bindvariables 
if the value changes at runtime.

3. Select the Database tab, if it is not already selected, and enter the following for 
each column that you wish to display in the spreadtable:

� Column Alias: The column alias becomes part of the primary key.

� View Column/ Function: Select from the LOVs the desired name of the 
View Column.

� Datatype: Select from the LOVs either character, number, or date.

� Query Sequence: The sequence value determines the order in which 
columns are extracted from the database. You could start with 1, but in 
actual practice, it is a good idea to leave gaps in the sequence for ease of 
row insertion later. To improve performance, begin with the columns that 
you will refer to in your code, typically the primary key columns to execute 
a query in a detail block.

� Sortable: Selecting this box allows the user to sort on this column.

� Default Sort Order: Sort in ascending or descending default order.

4. Select the Display tab, and enter the following for each column that you defined 
previously:

� Visible: Select to make this column visible in the spreadtable.

� Freeze Visible Property: Select if you want the end user to be able to 
change the visible properties (show/hide) at run time for this column.

� Display Sequence: The value determines the order in which the columns 
display in the spreadtable.

� Display Width: Sets the width (in pixels) of the displayed column. This 
value depends on the data that is displayed in the column.

� The Column Alias and Label fields are supplied automatically. However, 
you may change these values, if desired.

5. Select the Alignment and Formatting tab, and enter the following:
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Creating a New Dynamic Table
� Header Alignment: Select from the LOVs either Center, End, Right, or Start.

� Cell Alignment: Select from the LOVs either Center, End, Right, or Start.

� Display Type: Select from the LOVs either Checkbox, Hyperlink, or Text.

� Display Format: (Optional) Select from the LOVs either Currency, Date, or 
Date Time.

6. Select the Custom Format Masks and Mappings tab.

� Column Alias: The column alias field is filled automatically.

� Checkbox Mappings: These options apply only if the display type field in 
the Alignments and Formatting tab is set to Checkbox.

* Checked: Sets whether or not a column value is represented as a 
checked checkbox or as its corresponding image. 

* Unchecked: Sets whether or not a column value is represented as an 
unchecked checkbox or as its corresponding image. 

* Other: Sets how values other than those specified as either checked or 
unchecked are represented 

� Format Mask: Use to set how columns with datatype Number display data. For 
example, it would display the values as a percent. Use this only in rare cases. 

� Currency Column: Points to the database view column where the currency 
code for the current column is stored. This applies only if the display format 
is set to Currency.

7. Select the Sort Order tab, and perform the following:

� Choose the Primary Sort key from the LOVs. 

� You can optionally select a second or third Sort key from the List of Values.

8. Click the Save icon on the toolbar. (The icon looks like a floppy disk.)

9. Select the Test tab, and click Test. 

Your table displays. Refer to Using Dynamic Tables for additional information 
on spreadtables.
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